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Migrating from the Classic Agent to the Open
Agent

This document provides an overview of the basic concepts of the SilkTest Open Agent and explain the
differences between the Classic Agent and the Open Agent. If you plan to migrate from testing using the
SilkTest Classic Agent to the SilkTest Open Agent, review this information to learn how to migrate your existing
assets including window declarations and scripts.

Open Agent

The following topics explain how to get started with the SilkTest Open Agent:

• Overview of SilkTest Agents
• Overview of the Locator Keyword
• Recording Locators Using the Locator Spy
• Recording Window Declarations that Include Locator Keywords
• XPath Basic Concepts
• Supported XPath Subset
• Hierarchical Object Recognition

Differences Between the Classic Agent and the Open Agent

The following topics describe the key differences between the SilkTest Classic Agent and the Open Agent:

• Differences for Agent Options Between the Classic Agent and the Open Agent
• Differences in Object Recognition Between the Classic Agent and the Open Agent
• Differences in the Classes Supported by the SilkTest Open and Classic Agents
• Overview of the Methods Supported by the SilkTest Agents

Overview of SilkTest Agents
The SilkTest Agent is the software process that translates the commands in your 4Test scripts into GUI-specific
commands. In other words, the Agent drives and monitors the application you are testing. One Agent can run
locally on the host machine. In a networked environment, any number of Agents can run on remote machines.

SilkTest provides two types of Agents, the Open Agent and the Classic Agent. The Agent that you assign to
your project or script depends on the type of application that you are testing. The Open Agent provides the
majority of the same record capabilities as the Classic Agent and the same replay capabilities.

When you create a new project, SilkTest automatically uses the Agent that supports the type of application
that you are testing. For instance, if you create an Adobe Flex or Windows API-based client/server project,
SilkTest uses the Open Agent.

The SilkTest Open Agent supports the following technology types:

• Adobe Flex
• Java Applets
• Java AWT applications
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• Java Swing applications
• Java SWT /RCP applications
• SAP applications
• Windows API-based client/server applications
• Windows Forms
• Windows Presentation Foundation (WPF) applications
• xBrowser applications

When you open a project or script that was developed with the SilkTest Classic Agent, SilkTest automatically
uses the Classic Agent. For instance, if you upgrade from SilkTest 2006 to SilkTest Classic, SilkTest uses the
Classic Agent for your existing projects.

The SilkTest Classic Agent supports the following technology types:

• Java Applets
• Java AWT applications
• Java Swing applications
• Java SWT /RCP applications
• Web applications
• Web with ActiveX/Visual Basic applications
• Windows API-based client/server applications
• Windows Forms

Setting the Default Agent

SilkTest automatically assigns a default Agent to your project or scripts. When you create a new project, the
type of project that you select determines the default Agent. For instance, if you specify that you want to create
a Flex or Windows API-based client/server project, the Open Agent is automatically set as the default Agent.
When you open a project that was created with an earlier version of SilkTest, SilkTest detects which Agent
was used and sets it as the default Agent. At any time, you can configure SilkTest to automatically use the
Open Agent or the Classic Agent as the default Agent.To set the default Agent so the Agent that you use most
often is automatically assigned to scripts, click the appropriate icon in the toolbar or specify the default Agent
in the Runtime Options dialog box.

SilkTest automatically starts the default Agent when you open a project or create a new project.

When you enable extensions, set the recovery system, configure the application, or record a testcase, SilkTest
uses the default Agent.When you run a test, SilkTest automatically connects to the appropriate SilkTest Agent.
SilkTest uses the window declaration, locator, or Find or FindAll command to determine which SilkTest Agent
to use.

Differences in the Classes Supported by the SilkTest Open and Classic Agents

Slight differences exist in the classes available for each Agent.

Functions and Methods that Use the Classic Agent Only

Certain functions and methods run on the Classic Agent only. As a result, if you are running an Open Agent
project, the Classic Agent may also open because a function or method requires the Classic Agent.

To help you determine which methods are supported on each Agent, SilkTest includes two 4Test keywords.
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Overview of the Locator Keyword
Traditional SilkTest scripts that use the SilkTest Classic Agent use hierarchical object recognition. When you
record a script that uses hierarchical object recognition, SilkTest creates an include (.inc) file that contains
window declarations and tags for the GUI objects that you are testing. Essentially, the INC file serves as a
central global, repository of information about the application under test. It contains all the data structures that
support your testcases and test scripts.

When you record a testcase with the Open Agent, SilkTest creates locator keywords in an INC file to create
scripts that use dynamic object recognition and window declarations. The locator is the actual name of the
object, as opposed to the identifier, which is the logical name. SilkTest uses the locator to identify objects in
the application when executing testcases. Testcases never use the locator to refer to an object; they always
use the identifier.

You can also manually create testcases that use dynamic object recognition without locator keywords. Dynamic
object recognition uses a Find or FindAll function and an XPath query to locate the objects that you want
to test. No include file, window declaration, or tags are required.

The advantage of using locators with an INC file include:

• You combine the advantages of INC files with the advantages of dynamic object recognition. For example,
scripts can use window names in the same manner as traditional, SilkTest tag-based scripts and leverage
the power of XPath queries.

• Enhancing legacy INC files with locators facilitates a smooth transition from using hierarchical object
recognition to new scripts that use dynamic object recognition.You use dynamic object recognition but
your scripts look and feel like traditional, SilkTest tag-based scripts that use hierarchical object recognition.

• You can use AutoComplete to assist in script creation. AutoComplete requires an INC file.

Syntax

The syntax for the locator keyword is:

[ gui-specifier] locator  locator-string

where locator-string is an XPath string. The XPath string is the same locator string that is used for the Find
or FindAll functions.

Examples

The following example shows a window declaration that uses locators:

[-] window MainWin TestApplication
  [ ]locator "//MainWin[@caption='Test Application']"
  [ ]
  [ ] //The working directory of the application when it is invoked
  [ ] const sDir = "{SYS_GetEnv("SEGUE_HOME")}"
  [ ]
  [ ] //The command line used to invoke the application
  [ ] const sCmdLine = """{SYS_GetEnv("SEGUE_HOME")}testapp.exe"""

  [ ][-]Menu Control
    [ ]locator "//Menu[@caption='Control']"

    [-]MenuItem CheckBox
      [ ]locator "//MenuItem[@caption='Check box']"

    [-]MenuItem ComboBox
      [ ]locator "//MenuItem[@caption='Combo box']"
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    [-]MenuItem ListBox
      [ ]locator "//MenuItem[@caption='List box']"

    [-]MenuItem PopupList
      [ ]locator "//MenuItem[@caption='Popup list']"

    [-]MenuItem PushButton
      [ ]locator "//MenuItem[@caption='Push button']"

    [-]MenuItem RadioButton
      [ ]locator "//MenuItem[@caption='Radio button']"

    [-]MenuItem ListView
      [ ]locator "//MenuItem[@caption='List view']"

    [-]MenuItem PageList
      [ ]locator "//MenuItem[@caption='Page list']"

    [-]MenuItem UpDown
      [ ]locator "//MenuItem[@caption='Up-Down']"

    [-]MenuItem TreeView
      [ ]locator "//MenuItem[@caption='Tree view']"

    [-]MenuItem Textfield
      [ ]locator "//MenuItem[@caption='Textfield']"

    [-]MenuItem StaticText
      [ ]locator "//MenuItem[@caption='Static text']"

    [-]MenuItem TracKBar
      [ ]locator "//MenuItem[@caption='Track bar']"

    [-]MenuItem ToolBar
      [ ]locator "//MenuItem[@caption='Tool bar']"

    [-]MenuItem Scrollbar
      [ ]locator "//MenuItem[@caption='Scrollbar']"

  [-]DialogBox CheckBox
    [ ]locator "//DialogBox[@caption='Check Box']"
    [-]CheckBox TheCheckBox
      [ ]locator "//CheckBox[@caption='The check box']"

    [-]PushButton Exit
      [ ]locator "//PushButton[@caption='Exit']"

For example, if the script uses a menu item like this:

TestApplication.Control.TreeView.Pick()

Then the menu item is resolved by using dynamic object recognition Find calls using XPath locator strings.

The above statement is equivalent to:

Desktop.Find("//MainWin[@caption='Test
Application']//Menu[@caption='Control']//MenuItem[@caption='Tree
view']").Pick()
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Locator String Syntax

For convenience, you can use shortened forms for the XPath locator strings. SilkTest automatically expands
the syntax to use full XPath strings when you run a script.You can omit:

• The hierarchy separator, ".//". SilkTest defaults to using "//".
• The class name. SilkTest defaults to the class name of the window that contains the locator.
• The surrounding square brackets of the attributes,"[ ]".
• The "@caption='" if the xPath string refers to the caption.

The following locators are equivalent:

[-]Menu Control
  [ ]//locator "//Menu[@caption='Control']"
  [ ]//locator "Menu[@caption='Control']"
  [ ]//locator "[@caption='Control']"
  [ ]//locator "@caption='Control'"
  [ ]locator "Control"

You can use shortened forms for the XPath locator strings only when you use an INC file. For scripts that use
dynamic object recognition without an INC file, you must use full XPath strings.

Window Hierarchies

You can create window hierarchies without locator strings. In the following example, the "Menu Control" acts
only as a logical hierarchy, used to provide the INC file with more structure. "Menu Control" does not contribute
to finding the elements further down the hierarchy.

[-] window MainWin TestApplication
  [ ]locator "//MainWin[@caption='Test Application']"
  [-]Menu Control
    [-]MenuItem TreeView
      [ ]locator "//MenuItem[@caption='Tree view']"

In this case, the statement:

TestApplication.Control.TreeView.Pick()

is equivalent to:

Desktop.Find(".//MainWin[@caption='Test
Application']//MenuItem[@caption='Tree view']").Pick()

Including Locators and Tags in the Same Window Declaration

You can include locators and tags in the same window declaration. For example:

[-] window MainWin TestApplication
  [ ]locator "Test Application"
  [ ] tag "Test Application"
  [-]Menu Control
    [ ] tag"Control"
    [-]MenuItem TreeView
      [ ]locator "Tree view"
      [ ] tag "Tree view"

The following rules determine if locators or tags are used for resolving the window at runtime:
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• When replaying a script on the Classic Agent, only tags are used. Locators are never used with the Classic
Agent.

• When replaying a script on the Open Agent, locators are used if a locator is present for the bottom-most
window in the hierarchy and the Prefer Locator check box is checked in the General Options dialog box.
By default, the Prefer Locator check box is checked

• If the top-most window specifies a locator, the Open Agent is used.

In the preceding example, TestApplication.Control.Open() uses tags for resolving because the Menu
Control does not specify a locator.

TestApplication.Control.TreeView.Pick() uses locators for resolving because the MenuItem
TreeView specifies a locator and the Prefer Locator check box is checked.

Expressions

You can use expressions in locators. For example, you can specify:

STRING getSWTVersion()
  return SYS_GETENV("SWT_VERSION")
[-] window Shell SwtTestApplication
  [ ]locator "SWT {getSWTVersion()} Test Application"

Comparing the Locator Keyword to the Tag Keyword

The syntax of locators is identical to the syntax of the tag keyword.

The overall rules for locators are the same as for tags. There can be only one locator per window, except for
different gui-specifiers, in this case there can be only one locator per gui-specifier.

You can use expressions in locators and tags.

The locator keyword requires a script that uses the SilkTest Open Agent while the tag keyword requires a
script that uses the SilkTest Classic Agent.

Hierarchical Object Recognition
When you record window declarations, SilkTest records descriptions based on hierarchical object recognition
of the GUI objects in your application. SilkTest stores the declarations in an include file (*.inc).When you record
or replay a testcase, SilkTest references the declarations in the include file to identify the objects named in
your test scripts.

Using Hierarchical Object Recognition Versus Dynamic Object Recognition

Use hierarchical object recognition to test applications that require the SilkTest Classic Agent. Dynamic object
recognition requires the SilkTest Open Agent.

Alternatively, you can combine the advantages of INC files with the advantages of dynamic object recognition
by including locator keywords in INC files. Enhancing INC files with locators facilitates a smooth transition from
using hierarchical object recognition to new scripts that use dynamic object recognition. With locators, you use
dynamic object recognition but your scripts look and feel like traditional, SilkTest tag-based scripts that use
hierarchical object recognition.

You can create tests for both dynamic and hierarchical object recognition in your test environment.You can
use both recognition methods within a single testcase if necessary. Use the method best suited to meet your
test requirements.
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Open Agent Example

For example, if you record a test to open the New Window dialog box by choosing File/New/Window in the
SWT sample application, SilkTest:

• Records the following test:

testcase Test1 ()
recording
SwtTestApplication.WindowMenuItem.Pick()

• Creates window declarations in the include file for Window menu item. For example:

window Shell SwtTestApplication
  locator "/Shell[@caption='Swt Test Application']"
  MenuItem WindowMenuItem
    locator "//MenuItem[@caption='Window']"  

Classic Agent Example

For example, if you record a test to open the New Window dialog box by choosing File/New/Window in the
SWT sample application, SilkTest:

• Records the following test:

testcase Test1 ()
  recording
    SwtTestApplication.File.New.xWindow.Pick()

• Creates window declarations in the include file for File menu, Newmenu item, and xWindow menu item.
For example:

Menu File
  tag "File"
  MenuItem New
    tag "New.."
    MenuItem xWindow
      tag "Window"

XPath Basic Concepts
SilkTest supports a subset of the XPath query language. For additional information about XPath, see
http://www.w3.org/TR/xpath20/.

Basic Concepts

XPath expressions rely on the current context, the position of the object in the hierarchy on which the Find
method was invoked. All XPath expressions depend on this position, much like a file system. For example:

• "//Shell" finds all shells in any hierarchy relative to the current object.
• "Shell" finds all shells that are direct children of the current object.

Additionally, some XPath expressions are context sensitive. For example, myWindow.find(xPath) makes
myWindow the current context.
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Supported XPath Subset
SilkTest supports a subset of the XPath query language. Use a FindAll or a Find command followed by a
supported construct to create a test case.

The following table lists the constructs that SilkTest supports.

DescriptionSampleSupported XPath
Construct

Finds all menu items with the given
caption attribute in their object definition

MenuItem[@caption='abc']Attribute

that are children of the current context.
The following attributes are supported:
caption (without caption index),
priorlabel (without index), windowid.

Finds the first menu item that is a child
of the current context. Indices are
1-based in XPath.

MenuItem[1]Index

MenuItem[not
(@caption='a' or 

Logical Operators: and,
or, not, =, !=

@windowid!='b') and
@priorlabel='p']

Finds the context on which the Find
command was executed. For instance,

TestApplication.
Find("//Dialog[@caption=
'Check Box']/././.")

.

the sample could have been typed as
TestApplication.Find("//Dialog[@caption='Check
Box']").

Finds the parent of an object. For
instance, the sample finds a PushButton

Desktop.Find("//
PushButton[@caption=

..

with the caption "Ok" that has a sibling
PushButton with the caption "Previous."

'Previous']/../PushButton
[@caption='Ok']")

Finds all shells that are direct children
of the current object.

/Shell/

Note:  "/Shell" is equivalent to
"Shell".

Finds all menu items that are a child of
the current object.

/Shell/MenuItem/

Finds all shells in any hierarchy relative
to the current object.

//Shell//

Finds all menu items that are direct or
indirect children of a Shell that is a direct
child of the current object.

//Shell//MenuItem//

Finds all menu items that are direct or
indirect children of the current context.

//MenuItem//
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DescriptionSampleSupported XPath
Construct

Finds all objects with the given caption
that are a direct child of the current
context.

*[@caption='c']*

Finds all shells that are a grandchild of
a menu item.

//MenuItem/*/Shell*

 
The following table lists the XPath constructs that SilkTest does not support.

ExampleUnsupported XPath Construct

PushButton[@caption = @windowid]Comparing two attributes with each other

PushButton['abc' = @caption]An attribute name on the right side is not supported. An
attribute name must be on the left side.

PushButton [@caption = 'abc'] or
.//Checkbox

Combining multiple XPath expressions with 'and' or 'or'.

PushButton[@caption = 'abc] [@windowid
= '123']

(use PushButton [@caption = 'abc and
@windowid = '123'] instead)

More than one set of attribute brackets

PushButton[1][2]More than one set of index brackets

//[@caption = 'abc']

(use //*[@caption = 'abc'] instead)

Any construct that does not explicitly specify a class or the
class wildcard, such as including a wildcard as part of a class
name

"//*Button[@caption='abc']"

 

Recording Locators Using the Locator Spy
Capture a locator using the Locator Spy and copy the locator to the testcase or Clipboard.

To record locators with the Locator Spy, you must use the Open Agent.

1. Configure the application to set up the technology domain and base state that your application requires.

2. Choose File ➤ New.
The New File dialog opens.

3. Select 4Test script and then click OK.
A new 4Test Script window opens.

4. Choose Record ➤ Window Locators.
The Locator Spy opens.

5. Position the mouse over the object that you want to record and perform one of the following steps:

• Press Ctrl+Alt to capture the object with the default Record Break key sequence.
• Press Ctrl+Shift to capture the object if you specified the alternative Record Break key sequence

on the General Recording Options page of the Recording Options dialog box.
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Note:  For SAP applications, you must set Ctrl+Shift as the shortcut key combination to use to
pause recording. To change the default setting, choose Options ➤ Recorder and then check the
OPT_ALTERNATE_RECORD_BREAK check box.

• If you use Picking mode, click the object that you want to record and press the Record Break keys.

6. Click Stop Recording Locator.

SilkTest does not verify whether the locator string is unique. We recommend that you ensure that the string
is unique. Otherwise additional objects might be found when you run the test. Furthermore, you might want
to exclude some of the attributes that SilkTest identifies because the string will work without them.

The Locator text field displays the XPath query string for the object on which the mouse rests.The Locator
Details section lists the hierarchy of objects for the locator that displays in the text field.

7. To refine the locator, in the Locator Details table, click Show additional locator attributes, right-click an
object and then choose Expand subtree.
The objects display and any related attributes display in the Locator Attribute table.

8. To replace the locator that you recorded, select the locator that you want to use in the Locator Details table.
The new locator displays in the Selected Locator text box.

9. Copy the locator to the testcase or Clipboard.

To review the locator, click Paste Locator to Editor, review it and then paste the locator into the test.

To copy the locator to the Clipboard, click Copy Locator to Clipboard and then paste the locator into a
different editing window or into the current window at the location of your choice.

10. Click Close.

Recording Window Declarations that Include Locator
Keywords
A window declaration specifies a cross-platform, logical name for a GUI object, called the identifier, and maps
the identifier to the object's actual name, called the tag or locator.You can use locator keywords, rather than
tags, to create scripts that use dynamic object recognition and window declarations. Or, you can include locators
and tags in the same window declaration.

To record window declarations that include locator keywords, you must use the Open Agent.

1. Configure the application to set up the technology domain and base state that your application requires.

2. Choose Record ➤ Window Locators.
The Locator Spy opens.

3. Position the mouse over the object that you want to record and perform one of the following steps:

• Press Ctrl+Alt to capture the object with the default Record Break key sequence.
• Press Ctrl+Shift to capture the object if you specified the alternative Record Break key sequence

on the General Recording Options page of the Recording Options dialog box.

Note:  For SAP applications, you must set Ctrl+Shift as the shortcut key combination to use to
pause recording. To change the default setting, choose Options ➤ Recorder and then check the
OPT_ALTERNATE_RECORD_BREAK check box.

• If you use Picking mode, click the object that you want to record and press the Record Break keys.

4. Click Stop Recording Locator.
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The Locator text field displays the XPath query string for the object on which the mouse rests.The Locator
Details section lists the hierarchy of objects for the locator that displays in the text field.The hierarchy listed
in the Locator Details section is what will be included in the INC file.

5. To refine the locator, in the Locator Details table, click Show additional locator attributes, right-click an
object and then choose Expand subtree.
The objects display and any related attributes display in the Locator Attribute table.

6. To replace the hierarchy that you recorded, select the locator that you want to use as the parent in the
Locator Details table.
The new locator displays in the Locator text field.

7. Perform one of the following steps.

• To add the window declarations to the INC file for the project, position your cursor where you want to
add the window declarations in the INC file, and then click Paste Hierarchy to Editor.

• To copy the window declarations to the Clipboard, click Copy Hierarchy to Clipboard and then paste
the window declarations into a different editing window or into the current window at the location of your
choice.

8. Click Close.

Differences Between the Classic Agent and the Open Agent
The following topics describe the key differences between the SilkTest Classic Agent and the Open Agent:

Differences for Agent Options Between the Classic Agent
and the Open Agent
Before you migrate existing Classic Agent scripts to the Open Agent, review the Agent Options listed below
to determine if any additional action is required to facilitate the migration.

Action for Open AgentAgent Option

Option not needed. Note: Use OPT_REPLAY_MODE for
switching between high-level (API) clicks and low-level clicks.

OPT_AGENT_CLICKS_ONLY

Not supported by Open Agent.OPT_CLOSE_MENU_NAME

Option not needed.OPT_COMPATIBLE_TAGS

Not supported by Open Agent.OPT_COMPRESS_WHITESPACE

Option not needed.The Open Agent performs this action by
default during replay.

OPT_DROPDOWN_PICK_BEFORE_GET

Option not needed.OPT_EXTENSIONS

Not supported by Open Agent.OPT_GET_MULTITEXT_KEEP_EMPTY_LINES

Not supported by Open Agent.OPT_KEYBOARD_LAYOUT

No action. Pop-up menu handling using the Open Agent
does not need such an option.

OPT_MENU_INVOKE_POPUP

Option not needed.OPT_MENU_PICK_BEFORE_GET
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Action for Open AgentAgent Option

Option not needed.OPT_NO_ICONIC_MESSAGE_BOXES

TrueLog Explorer is not supported on the Open Agent.OPT_PAUSE_TRUELOG

Option not needed.OPT_PLAY_MODE

Open Agent always sees RadioList items as individual
objects.

OPT_RADIO_LIST

Obsolete option.OPT_REL1_CLASS_LIBRARY

Use the option OPT_ENSURE_ACTIVE instead.OPT_REQUIRE_ACTIVE

Option not needed. Open Agent only requires scrolling into
view for low-level replay. By default, high-level replay is

OPT_SCROLL_INTO_VIEW

used, so no scrolling needs to be performed. However,
CaptureBitmap never scrolls an object into view.

Option not needed.OPT_SET_TARGET_MACHINE

Option not needed. Out-of-view objects are always
recognized.

OPT_SHOW_OUT_OF_VIEW

Option not needed. The Open Agent always uses 'Enter' to
type a new line.

OPT_TEXT_NEW_LINE

Not supported by Open Agent.OPT_TRANSLATE_TABLE

Fault trap is no longer active.OPT_TRAP_FAULTS

Fault trap is no longer active.OPT_TRAP_FAULTS_FLAGS

Option not needed. If required, use a * wildcard instead.OPT_TRIM_ITEM_SPACE

Not supported by Open Agent.OPT_USE_ANSICALL

SilkBean is not supported on the Open Agent.OPT_USE_SILKBEAN

Option not needed.The Open Agent performs this action by
default.

OPT_VERIFY_APPREADY

Option not needed.The Open Agent performs this action by
default.

OPT_VERIFY_CLOSED

Option not needed.The Open Agent does not typically check
for native input in order to allow clicking outside of an object.

OPT_VERIFY_COORD

Option not needed.OPT_VERIFY_CTRLTYPE

Option not needed. The Open Agent performs this action
when it sets a window to active.

OPT_VERIFY_EXPOSED

OPT_ENSURE_ACTIVE_OBJECT_DEF should yield the
same result.

Option not needed.OPT_VERIFY_RESPONDING

Option not needed.OPT_WINDOW_MOVE_TOLERANCE
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Differences in Object Recognition Between the Classic
Agent and the Open Agent
When recording and executing testcases, the Classic Agent uses the keywords 'tag' or 'multitag' in a window
declaration to uniquely identify an object in the test application. The tag is the actual name, as opposed to the
identifier, which is the logical name.

When using the Open Agent, you typically use dynamic object recognition with a Find or FindAll function
and an XPath query to locate objects in your test application.To make calls that use window declarations using
the Open Agent, you must use the keyword 'locator' in your window declarations. Similar to the 'tag' or
'multitag' keyword, the locator is the actual name, as opposed to the identifier, which is the logical name.
This similarity facilitates a smooth transition of legacy window declarations, which use the Classic Agent, to
dynamic object recognition, which leverages the Open Agent.

The following sections explain how to migrate the different tag types to valid locator strings.

Caption

Classic Agent: tag "<caption string>"

Open Agent: locator "//<class name>[@caption='<caption string>']"

Note:  For convenience, you can use shortened forms for the XPath locator strings. SilkTest automatically
expands the syntax to use full XPath strings when you run a script.

You can omit:

• The hierarchy separator, ".//". SilkTest defaults to "//".
• The class name. SilkTest defaults to the class name of the window that contains the locator.
• The surrounding square brackets of the attributes, "[ ]".
• The "@caption=" if the XPath string refers to the caption.

Example:

Classic Agent:

CheckBox CaseSensitive
  tag "Case sensitive"

Open Agent:

CheckBox CaseSensitive
  locator "//CheckBox[@caption='Case sensitive']"

Or, if using the shortened form:

CheckBox CaseSensitive
  locator "Case sensitive"

Note:  Classic Agent removes ellipses (…) and ampersands (&) from captions. Open Agent removes
ampersands, but not ellipses.

Prior text

Classic Agent: tag "^Find What:"

Open Agent: locator "//<class name>[@priorlabel='Find What:']"
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Note:  Only available for Windows API-based and Java Swing applications. For other technology domains,
use the Locator Spy to find an alternative locator.

Index

Classic Agent: tag "#1"

Open Agent: Record window locators for the test application. The Classic Agent creates index values based
on the position of controls, while the Open Agent uses the controls in the order provided by the operating
system. As a result, you must record window locators to identify the current index value for controls in the test
application.

Window ID

Classic Agent: tag "$1041"

Open Agent: locator "//<class name>[@windowid='1041']"

Location

Classic Agent: tag "@(57,75)"

Open Agent: not supported

Note:  If you have location tags in your window declarations, use the Locator Spy to find an alternative
locator.

Multitag

Classic Agent: multitag "Case sensitive"

"$1011"

Open Agent: locator "//CheckBox[@caption='Case sensitive' or @windowid='1011']"

'parent' statement

No changes needed. Multitag works the same way for the Open Agent.

GetChildren Method of Window Object in the Open Agent versus WindowChildren Method in the Classic
Agent

The GetChildren method of a Window in the Open Agent does not provide the exactly same functionality
as the WindowChildren method in the Classic Agent. If the declaration of a window includes a declaration
for a child window, the WindowChildren method in the Classic Agent returns the corresponding child window.
This functionality is not available in the Open Agent. The GetChildren method of a Window in the Open
Agent returns all child windows of a window, independent of whether they are declared in the window declaration
or not.

Differences in the Classes Supported by the SilkTest
Open and Classic Agents
The SilkTest Classic Agent and the Open Agent differ slightly in the types of classes that they support. These
differences are important if you want to manually script your testcases. Or, if you are testing a single test
environment with both the Classic Agent and the Open Agent. Otherwise, the Open Agent provides the majority
of the same record capabilities as the Classic Agent and the same replay capabilities.
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Windows-based Applications

Both Agents support testing Windows API-based client/server applications.The Open Agent classes, functions,
and properties differ slightly from those supported on the Classic Agent for Windows API-based client/server
applications.

Open AgentClassic Agent

AnyWinAnyWin

AgentClass (Agent)AgentClass (Agent)

CheckBoxCheckBox

<no corresponding class>ChildWin

ClipboardClass (Clipboard)ClipboardClass (Clipboard)

ComboBoxComboBox

ControlControl

CursorClass (Cursor)CursorClass (Cursor)

CustomWinCustomWin

<no corresponding class>DefinedWin

DesktopWin (Desktop)DesktopWin (Desktop)

DialogBoxDialogBox

<no corresponding class>DynamicText

HeaderExHeader

ListBoxListBox

ListViewExListView

MainWinMainWin

MenuMenu

MenuItemMenuItem

<no corresponding class>MessageBoxClass

MoveableWinMoveableWin

PageListPageList

ComboBoxPopupList

<no corresponding class>PopupMenu

<no corresponding class>PopupStart

<no corresponding class>PopupSelect

PushButtonPushButton

RadioButton
Note:  Items in Radiolists are recognized as
RadioButtons on the CA. OA only identifies all of those
buttons as RadioList.
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Open AgentClassic Agent

RadioListRadioList

ScaleScale

ScrollBar, VerticalScrollBar, HorizontalScrollBarScrollBar

StaticTextStaticText

StatusBarStatusBar

<no corresponding class>SysMenu

TableExTable

<no corresponding class>TaskbarWin (Taskbar)

TextFieldTextField

ToolBar

Additionally: PushToolItem, CheckBoxToolItem

ToolBar

TreeViewTreeView, TreeViewEx

UpDownExUpDown

 
The following core classes are supported on the SilkTest Open Agent only:

• CheckBoxToolItem
• DropDownToolItem
• Group
• Item
• Link
• MonthCalendar
• Pager
• PushToolItem
• RadioListToolItem
• ToggleButton
• ToolItem

Web-based Applications

Both Agents support testing Web-based applications.The Open Agent classes, functions, and properties differ
slightly from those supported on the Classic Agent for Windows API-based client/server applications.

Open AgentClassic Agent

BrowserApplicationBrowser

BrowserWindowBrowserChild

DomCheckBoxHtmlCheckBox

<no corresponding class>HtmlColumn

<no corresponding class>HtmlComboBox

DomFormHtmlForm
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Open AgentClassic Agent

<no corresponding class>HtmlHeading

<no corresponding class>HtmlHidden

<no corresponding class>HtmlImage

DomLinkHtmlLink

<no corresponding class>HtmlList

DomListBoxHtmlListBox

<no corresponding class>HtmlMarquee

<no corresponding class>HtmlMeta

DomListBoxHtmlPopupList

DomButtonHtmlPushButton

DomRadioButtonHtmlRadioButton

<no corresponding class>HtmlRadioList

DomTableHtmlTable

<no corresponding class>HtmlText

DomTextFieldHtmlTextField

<no corresponding class>XmlNode

<no corresponding class>Xul* Controls

 

Java AWT/Swing Applications

Both Agents support testing Java AWT/Swing applications.The Open Agent classes, functions, and properties
differ slightly from those supported on the Classic Agent for Windows API-based client/server applications.

Open AgentClassic Agent

AppletContainerJavaApplet

AWTDialog, JDialogJavaDialogBox

AWTFrame, JFrameJavaMainWin

AWTCheckBoxJavaAwtCheckBox

AWTListJavaAwtListBox

AWTChoiceJavaAwtPopupList

<no corresponding class>JavaAwtPopupMenu

AWTPushButtonJavaAwtPushButton

AWTRadioButtonJavaAwtRadioButton

<no corresponding class>JavaAwtRadioList

AWTScrollBarJavaAwtScrollBar
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Open AgentClassic Agent

AWTLabelJavaAwtStaticText

AWTTextField, AWTTextAreaJavaAwtTextField

JCheckBoxJavaJFCCheckBox

JCheckBoxMenuItemJavaJFCCheckBoxMenuItem

<no corresponding class>JavaJFCChildWin

JComboBoxJavaJFCComboBox

<no corresponding class>JavaJFCImage

JListJavaJFCListBox

JMenuJavaJFCMenu

JMenuItemJavaJFCMenuItem

JTabbedPaneJavaJFCPageList

JListJavaJFCPopupList

JPopupMenuJavaJFCPopupMenu

JProgressBarJavaJFCProgressBar

JButtonJavaJFCPushButton

JRadioButtonJavaJFCRadioButton

JRadioButtonMenuItemJavaJFCRadioButtonMenuItem

<no corresponding class>JavaJFCRadioList

JSliderJavaJFCScale

JScrollBar, JHorizontalScrollBar, JVerticalScrollBarJavaJFCScrollBar

JComponentJavaJFCSeparator

JLabelJavaJFCStaticText

JTableJavaJFCTable

JTextField, JTextAreaJavaJFCTextField

JToggleButtonJavaJFCToggleButton

JToolBarJavaJFCToolBar

JTreeJavaJFCTreeView

JSpinnerJavaJFCUpDown

 

Java SWT/RCP Applications

Both Agents support testing Java SWT/RCP-based applications. The Open Agent classes, functions, and
properties differ slightly from those supported on the Classic Agent for Java SWT/RCP-based applications.
The Java SWT/RCP classes and methods for the Classic Agent do not work with the Open Agent. For a list
of the classes for each Agent, see:
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• Supported SWT Widgets for the Open Agent
• Supported SWT Widgets for the Classic Agent

Overview of the Methods Supported by the SilkTest
Agents
The winclass.inc file includes information about which methods are supported for each SilkTest Agent. The
following 4Test keywords indicate Agent support:

• supported_ca - Supported on the Classic Agent only
• supported_oa - Supported on the Open Agent only

Standard 4Test methods, such as AnyWin::GetCaption(), can be marked with one of the preceding
keywords. A method that is marked with the supported_ca or supported_oa keyword can only be executed
successfully on the corresponding Agent. Methods that do not have a keyword applied will run on both Agents.

To find out which methods are supported on each Agent, open the .inc file (for instance, winclass.inc) and
verify whether the supported_ca or supported_oa keyword is applied to it.

SilkTest Classic Agent

Certain functions and methods run on the Classic Agent only. When these are recorded and replayed, they
default to the Classic Agent automatically.You can use these in an environment that uses the Open Agent.
SilkTest automatically uses the appropriate Agent. The functions and methods include:

• C data types for use in calling functions in DLLs
• ClipboardClass Class methods
• CursorClass Class methods
• Certain SYS functions
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